
 

 

 

QUICK SETUP GUIDE 
 

 

MEMOCam® 
MEMOCam®PLUS 

MEMOCam®PLUS/S 



 

 

 

 

 

 

 

 

 

 

 

 

 

Version 3.2.001 

 



 

 

Copyright © Video Domain Technologies Ltd. 2003 

The information in this manual was accurate and reliable at the time of its release. However, Video Domain Technologies Ltd. reserves 
the right to change the specifications of the product described in this manual without notice at any time. As such, the descriptions and 
data included in this document may not be current. Video Domain Technologies Ltd. assumes no responsibility for any inconsistencies 
between the actual product and this manual's description of it. Any party electing to use this manual does so with the full knowledge of 
the possibility of such inconsistencies and takes full responsibility for any consequences that may arise while installing and/or using this 
product. 
Video Domain Technologies Ltd. holds the copyright to this manual. All rights are reserved. No part of this publication may be 
reproduced or transmitted in any form or by any means without prior written consent from Video Domain Technologies Ltd. 

Disclaimer 

Video Domain Technologies Ltd. make no warranties regarding the content of this document. Video Domain Technologies Ltd. reserves 
the right to alter, modify and revise the specification without notice. Video Domain Technologies Ltd. assumes no responsibility for any 
errors contained herein. 

The customer should note that in the field of multimedia there are a number of patents held by various parties. It is the responsibility of 
the user to assure that a particular implementation does not infringe on those patents. Video Domain Technologies Ltd. does not 
indemnify the user from any patent or intellectual property infringement. 

Registered Trademarks 

All other proprietary names mentioned in this manual are the trademarks of their respective owners. 

Video Domain Technologies Ltd. 
www.vdomain.com 



 

 

Manufacturer: Video Domain Technologies Ltd.  
Model: MemoCam    
Rated voltage(s): 12VDC 
Current(s) (or power): 0.5 A 

This device complies with Part 15 of the FCC Rules. 

Operation is subject to the following two conditions: 

(1)This device may not cause harmful interference, and 

(2) This device must accept any interference received, including interference that may cause undesired operation. 

This Class A/B digital apparatus complies with Canadian ICES-003. 

Cet appareil numẻrique de la classe A/B est conforme ả la norme NMB-003 du Canada. 

 FCC 

Changes or modifications not expressly approved by Video Domain could void the user’s authority to operate the equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 
-- Reorient or relocate the receiving antenna. 
-- Increase the separation between the equipment and receiver. 
-- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
-- Consult the dealer or an experienced radio/TV technician for help. 
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GETTING ACQUAINTED 

Congratulations on your purchase of 
MemoCam®. To use MemoCam most 
effectively, start by learning how to: 

� Install MemoCam. 

� Use MemoCam to record images. 

� View recorded images. 

 This guide describes the basic features you 
need to begin working with MemoCam. For 
detailed information about all of MemoCam’s 
many features, refer to the MemoCam 
Installation Manual and MemoCam Software 
Manual (on the software CD). 

What is in the Box? 

Your MemoCam is shipped with: 

� MemoCam unit. 

� 16 MB or higher Multimedia card. 

� Protective card cover. 

� Bracket Mounting kit. 

� Power adapter. 

� Remote control unit, including 2 AAA 
batteries. 

� MemoCam software CD. 

� MemoCam Quick Setup Guide (this guide), 
and the MemoCam Installation Guide. 
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If items are missing, contact your local 
Video Domain representative. 

Introduction to MemoCam 

The MemoCam is a wall-mounted compact 
standalone CCTV system in a single device. For 
detailed information about MemoCam, refer to 
the MemoCam Installation Manual. 

MemoCam includes: 

� CCD camera. 

� Video compression engine. 

� Removable Multimedia card. 

� Passive Infra-Red (PIR) motion detector. 

� MemoCam software application. 

The events recorded by MemoCam can be 
viewed on a PC with Windows 95, 98, 2000, 
ME, NT, or XP with Internet Explorer TM 5.0 (or 
higher), or a Pocket PC with Windows CE 3.0 

(or higher). The images are read from the 
Multimedia card using a card reader and the 
MemoCam software. 

MemoCam Unit 
The MemoCam unit is a high performance 
camera with automatic digital recording 
features contained in a single device. 
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Figure 1. MemoCam Unit – Front View 

 

Figure 2. MemoCam Unit – Rear View 
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As illustrated in Figure 1 and Figure 2, the 
MemoCam unit has the following components: 

� Internal camera. 

� LEDs. 

� PIR. 

� Protective Multimedia card cover. 

� Power connector. 

� Wall mount. 

� Multimedia card slot. 

MemoCam has the following LED indicators: 

Table 1. MemoCam LEDs 

LED Color Description 

Left 

(Multimedia 
Card Status) 

Red Error or Multimedia 
card is faulty or not 
inserted correctly 

 Blinking 
Green 

Data is being written 
to the Multimedia 
card 

 Orange Multimedia card is 
full 

Middle 

(PIR Activation) 

Flashing 
Red 

Movement detected 

Right 

(Arm Mode) 

Orange 

None 

ARM mode 

DISARM mode 
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Remote Control Unit 

The remote control unit is used to activate 
(arm), deactivate (disarm), and manually record 
image snapshots. For more information, refer 
to the MemoCam Installation Manual. 

 Insert 2 AAA batteries into the remote control 
unit before use.  

 

Figure 3. Remote Control Unit 
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Mounting Bracket 
The mounting bracket is used to mount the 
MemoCam unit on the wall. For more 
information, refer to Mounting the MemoCam 
Unit on page 7. 

 

Figure 4. Mounting Bracket 

MultiMedia Card Reader 
The Multimedia card supplied with MemoCam 
can be used with any standard card reader. For 
more information, refer to the documentation 
supplied with the Multimedia Card Reader. 
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INSTALLING MEMOCAM 

Mounting the MemoCam Unit 

Begin by selecting a mounting location on the 
wall. Choose a location most likely to intercept 
an intruder. Make sure that the MemoCam 
power cord can reach a nearby power 
receptacle. If necessary, use an extension cord. 

The MemoCam performs best in steady light 
and stable temperature, and is most sensitive 
in detecting sideways motion. 

Avoid the following locations: 

� Facing direct sunlight or light sources. 

� Facing areas subject to rapid quick 
temperature changes. 

� Areas with air ducts or substantial air 
flows. 

� Facing areas with high light contrast. 

To mount the MemoCam: 

1. Loosen the two pieces of the mounting 
bracket without separating them. The two 
sections of the bracket should swing freely. 

2. Place the wall-mount section of the bracket 
on the desired location on the wall, and 
mark the drill points through the two 
fastener holes. 

3. Drill the holes (if necessary) and attach the 
bracket to the wall with screws. 

4. Retighten the two mounting bracket pieces 
so that the MemoCam Mount section can 
still be rotated with slight pressure.  



 

8  

5. Clip the upper part of the MemoCam unit’s 
holder to the bracket and rotate, as 
indicated in Figure 5, until the MemoCam 
snaps into place. 

6. Adjust the position of the MemoCam unit 
by moving it slowly up/down and left/right 
to the desired position. 

7. Remove the MemoCam unit carefully from 
the bracket without changing the bracket 
position. 

8. Tighten the two mounting bracket pieces 
firmly to prevent further movement. 

9. Re-attach the MemoCam to the bracket as 
indicated in step 5 above.  

Figure 5. Mounting the MemoCam Unit 
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Connecting the Power Supply 

Connect the power adapter to the 
MemoCam power connector (Figure 2). Plug 
the power adapter into a wall socket. The 
MemoCam status LED indicators light, as 
described in Table 1. 

Installing MemoCam Software for 
Windows 

Before you install the MemoCam software, 
make sure your computer or Pocket PC meets 
the system requirements on page 10. 

To install MemoCam software: 

1. If you are using Windows NT, verify that the 
Active Desktop feature is active. 

2. Insert the MemoCam Software CD into the 
CD-ROM drive. The CD Browser Screen 
appears automatically. 

 If the CD Browser Screen doesn’t appear 
automatically, open Windows Explorer to the 
CD-ROM drive, and double-click 
MCBrowse.exe. 

3. Click Install MemoCam. The Install Wizard 
begins. 

4. Click Next on the Opening window of the 
Install Wizard. The MemoCam files are 
installed and the Finishing Window appears. 

5. Select the Restart option and click Finish. 
Your computer is automatically rebooted. 

For more information and complete installation 
instructions, refer to the MemoCam Software 
Manual. 
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MemoCam System Requirements 
The following are the minimum system 
requirements for installing the MemoCam 
viewer application on a PC or a Pocket PC. 

PC Minimum Requirements 

CPU Pentium II 200MHz or higher 

RAM 16MB or higher 

Graphic adapter Super VGA or higher 

Display resolution 640x480, 16 bit or higher 

Operating 
systems 

Windows 95, 98, 2000, ME, NT, 
or XP and Internet ExplorerTM 5.0 
or higher 

Multimedia Card 
Reader 

 

 

Pocket PC Minimum Requirements 

CPU ARM (or compatible) 

RAM 16MB or higher 

Display resolution 320x240, 16 bit or higher 

Operating systems Windows CE 3.0 or higher 

Multimedia Card Reader  

Installing the Multimedia Card 
Reader 

To install the Multimedia Card Reader on your 
computer, follow the directions in the 
documentation supplied with the Multimedia 
Card Reader. 
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USING MEMOCAM 

To use MemoCam, you need to insert the 
Multimedia card into the MemoCam unit and 
arm MemoCam using the remote control unit. 
These steps are described in detail in the 
sections below. 

Inserting and Removing the 
Multimedia Card 

MemoCam comes with a protective cover over 
the Multimedia card slot. Remove this cover 
before inserting or removing the Multimedia 
card.  For more information about the 
protective cover, refer to the MemoCam 
Installation Manual. 

Insert the Multimedia card into the slot on the 
bottom of the MemoCam. Push the card gently 

until you hear a click (refer to Figure 6). Wait 3 
or 4 seconds for the MemoCam unit to read 
the card. 

 

Figure 6. Inserting the Multimedia Card 

To remove the Multimedia card, push the card 
gently inwards until you hear a click and then 
slowly pull the card downward. 
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Arming MemoCam 

To activate (arm) MemoCam: 

1. Verify that MemoCam is plugged in and the 
Multimedia card is inserted into the unit. 

2. Point the remote control unit at MemoCam 
and press Arm (refer to Figure 3). 
MemoCam emits one long beep and the 
Arm Mode (right) LED lights orange (refer 
to Figure 1). 

Disarming MemoCam 

To deactivate (disarm) MemoCam: 

1. Point the remote control unit at the 
MemoCam unit and enter the disarm code 
using the buttons labeled 1-4 on the remote 
control unit (refer to Figure 3). 

 The default disarm code is: 1234. 

2. Press Disarm (refer to Figure 3). MemoCam 
beeps three times and the Arm mode LED 
turns off. 
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VIEWING THE IMAGES 

This section describes the basic features you 
need to begin working with the MemoCam. 
For detailed information about all of 
MemoCam’s many features, refer to the 
MemoCam Software Manual. 

To view the images recorded by MemoCam on 
the Multimedia card: 

1. Disarm MemoCam (refer to Disarming 
MemoCam on page 12). 

2. Remove the Multimedia card from the 
MemoCam (refer to Inserting and Removing 
the Multimedia Card on page 11). 

3. Insert the Multimedia card into the card 
reader attached to your computer or Pocket 
PC. 

4. Click  on your desktop to open the 
MemoCam application. The MemoCam 
window opens, displaying the list of images 
on the Multimedia card. 

 If there is no Multimedia card in the reader, the 
MemoCam application opens a file containing 
sample images. 
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Figure 7. MemoCam Image List 

Viewing the Image List 

You can view the Image List displayed in the 
MemoCam window in either of the following 
ways: 

� As a detailed list, in which the image 
name, date and time of creation, as well as 
other details are displayed.  
To display the Image List as a detailed list, 
click  or open the View menu and 
click Details. 
For more information, refer to the 
MemoCam Software Manual. 

� As thumbnails of the images.  
To display the Image List as thumbnails, 
click  or open the View menu and 
click Thumbnails. 
For more information, refer to the 
MemoCam Software Manual. 
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Playing the Images 

You can view images consecutively in the 
MemoCam Image Viewer. The images are 
played in the order they appear in the Image 
List. 

To play images: 

1. Double-click an image in the list. 

OR 

1. Select an image in the list. 

2. Open the Edit menu and select Play. 
 

Figure 8. Image in MemoCam Image Viewer 

The images are displayed one after another in 
the MemoCam Image Viewer. A toolbar to 
control the viewing of images appears on the 
top of the window. 
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The MemoCam Image Viewer toolbar contains 
the following buttons: 

Button Description 

 
Plays the images backwards. 

 
Plays the images forwards. 

 
Pauses playing the images. 

 
Displays the current image in your 
PC’s default viewer. 

 
Displays the previous image. 

 
Displays the next image. 

 
Checks the image integrity. Enter the 
integrity key or load the key from a 
file. For more information, refer to 
the MemoCam Software Manual. 

 
Adjusts the speed at which 
the images are displayed. 
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CHECKING THE INSTALLATION 

To check that MemoCam was installed 
successfully and is operational: 

1. Make sure the Multimedia card is inserted in 
the MemoCam unit (refer to Inserting and 
Removing the Multimedia Card on 
page 11). 

2. Disarm MemoCam (refer to Disarming 
MemoCam on page 12). 

3. Point the remote control unit at the 
MemoCam unit and press Rec. The 
Multimedia Card Status (left) LED blinks 
green. 

4. Remove the Multimedia card from the 
MemoCam (refer to Inserting and Removing 
the Multimedia Card on page 11). 

5. Insert the Multimedia card into the card 
reader attached to your computer or Pocket 
PC. 

6. View the image as described in Viewing the 
Images on page 13. 

If you encounter any problems during this 
process, refer to Troubleshooting on page 18, 
or to the MemoCam Installation Manual. 
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TROUBLESHOOTING 

The following table provides solutions to some 
common problems.  For more troubleshooting 
information, refer to the MemoCam Installation 
Manual. Should you require further assistance 
or support, visit the support section of our web 
site at www.vdomain.com and file a problem 
report, or contact your local Video Domain 
representative. 

Problem Symptom Solution 

Unit does not 
work. 

Impossible to operate 
unit, and LEDs don’t 
light. 

Check power supply 
and power cable.  

Remote control 
does not work. 

Unit does not arm and 
other remote control 
functions do not work. 
No beeping. 

Check remote control 
batteries. 

MemoCam 
application does 
not start 
correctly. 

 Check that you 
installed the 
application as 
described in the 
manual. If not, reinstall 
the application. 

No images are 
recorded 

The MemoCam 
software displays 
demo pictures 

Check that the 
Multimedia card is 
inserted correctly. 

 



 

 

LICENSE AND LIMITED WARRANTY AGREEMENT 
The opening of the packaging of the Software and/or the installation of the Software and/or the use of the Product shall be deemed that you have read and 
accepted the terms of this License and Limited Warranty Agreement. 
If you do not agree to the terms of this agreement, do not use the product. Promptly return the entire package to the place where you obtained it. 
General Terms 
You have purchased the right to use the software embedded in some integrated circuits of this Product and on the 
enclosed disks and/or CD_ROM (the ‘Software’) and you have purchased the hardware that is the other part of the 
Product (the ‘Hardware’), together (the ‘Product’) produced by Video Domain Technologies (‘VDT’). 
If the Hardware or the Software does not function properly, please return the Product, together with the copy of your 
paid receipt, to the place where you obtained it. 
License 
VDT grants you a license to use the Software subject to terms and conditions of the License agreement hereto. You 
do not own the Software. VDT and/or third parties remain the sole owner of the Software. The Software and 
accompanying documentation are proprietary products of VDT and/or third parties, and all title, trade secrets, trade 
names, trademark patents, copyrights and any other intellectual and proprietary rights, in the Product whether 
registered or not, remain the sole property of VDT and/or third parties. The intellectual property rights of VDT and/or 
third parties in the Product are protected by law. 
Your rights in the Software are limited to installation of the Software, in the machine-readable form in accordance 
with the instructions VDT provided you, executing the Software after installation, and making an archive copy(s) in 
the form provided for backup purposes. 
The Software may be used only in conjunction with the Hardware you bought, as an integral part of the Product. Any 
attempt to determine the source code for the Software; to modify, reprogram, translate, dissemble, decompose, or 
otherwise reverse engineer the Software; selling sublicense, transferring the Software to anyone else; or allowing any 
one the access or execute the Software through time sharing services or as a service bureau are forbidden. Any 
attempt to do any of these forbidden activities will automatically terminate your tight to use the Software and our 
Limited Warranty without any notice from use. 
Warranty 
The Product, including the media on which the Software is delivered, is warranted to be free of defects in material 
and workmanship and shall comply with VDT specifications, for a period of 12 months of normal use from the date 
of purchase (‘the Warranty Period’). 
The Warranty is void if VDT’s instructions of operation, checking and maintenance are ignored, if attempts to repair 
the Product have been done before the Product is returned to the place where you obtained it. Responsibility for 
normal wear and tear is excluded. 
The Product is provided ‘As Is’ and without Warranty, by VDT and/or the distributor and/or the importer, if the 
importer is not a distributor (each hereinafter the ‘Distributor’) of the Product, in the country where the product was 
purchased, or our suppliers, express or implied, including without limitation implied warranty of merchantability of 
fitness any particular purpose. 
During the Warranty Period, VDT’s and/or VDT’s Distributor sole obligation, in tort, contract, or otherwise, shall be to 
repair or replace the defective Product, at VDT’s option. The repair or replacement of the defective Product during the 

Warranty Period will not extend the Warranty Period. The Warranty does not cover failures resulting from improper 
operation, connection, or installation. 
For your convenience, VDT’s obligations in connection to Warranty claims, repairs service and instructions have been 
transferred to VDT’s Distributor in your country. The Distributor is responsible for providing you with all necessary 
services (If you need the details of the Distributor in your country, please contact VDT).  
Disclaimer 
VDT and/or the Distributor make no Warranty, Representation or promise expressed or implied that the Hardware 
and/or the Software or associated documentation will satisfy your requirements and/or that the hardware or software 
and documentation are without defect or error or that the operation of the hardware and software will 
uninterrupted or error free.   
Limitation of Liability 
Except as otherwise restricted by Law, VDT’s and/or distributor’s aggregate liability arising from or relating to your 
purchase and/or use of the Hardware and/or Software, the associated documentation or any services provided by VDT 
and/or the distributor, is limited to the total of all payments made by or for you for the Hardware and Software and 
documentation. 
Neither VDT nor the Distributor or any of their licensors, directors, employees, or any body acting on their behalf shall 
in any case be responsible or liable for any special, incidental, consequential, indirect or punitive damages, even if 
advised of the possibility of those damages and/or for lost profits or revenue, loss of contracts, loss of data, costs or 
re-creating lost data, and/or the cost of any substitute Hardware and/or Software and/or equipment or programs. 
Governing Law and Jurisdiction 
Except as otherwise restricted by law, this Agreement shall be governed only by, and interpreted, in accordance with 
the laws of the State of Israel and the exclusive jurisdiction shall be vested to the local courts of Tel Aviv. 

Entire Agreement 
This Agreement sets forth the entire understanding and rights and duties between you and VDT. This Agreement may 
be amended only in writing signed by both parties.  No person or entity is authorized to modify this Agreement or to 
make any warranty, representation or promise which is different than, or in addition to, the representation or 
promises of this   agreement. 
Waiver 
No waiver of any right under this Agreement shall be effective unless in writing, signed by a duly authorized 
representative of the party to be bound.  No waiver of any past or present right arising from any breach or failure to 
perform shall be deemed to be a waiver of any future right arising under this Agreement. 
Severability 
If any provision in this Agreement is invalid or unenforceable, that provision shall be construed, limited, modified or, if 
necessary, severed, to the extent necessary, to eliminate its invalidity or unenforceability, and the other provisions of 
this Agreement shall remain unaffected. 

www.vdomain.com                                                              PN/V7122550 


